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Android leaps beyond RIM to take top spot in U.S. market | Android Atlas - CNET Reviews
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Android leaps beyond RIM to take top spot in U.S.

market

by Scott Webster

Android is the now most popular
mobile platform for
smartphones in the United
States, says a study released
yesterday. According to the
ComScore survey, Google's OS
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Top Smartphone Platforms

3 Month Avg. Ending Jan. 2011 vs. 3 Month Avg. Ending Oct. 2010

Total U.S. Smartphone Subscribers Ages 13+

Source: comScore MobilLens

Share (%) of Smartphone Subscribers

Oct-10 Jan-11 Point
Change

Total Smartphone Subscribers | 100.0% 100.0% N/A
Google 23.5% 31.2% 7.7

RIM 35.8% 30.4% 5.4
Apple 24.6% 24.7% 0.1

Microsoft 9.7% 8.0% -1.7
Palm 3.9% 3.2% -0.7

source: comScore
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Samsung Electronics
(@) Quotes Delayed

News 16:27, 23 Mar

Samsung latest android
Samsung has announced the
first Android 2.1 smartphone ...
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MOTOROLA XOOM - Android Smart Tablet - Overview - Motorola Mobility, Inc. USA

> ] [+ @ http:/ /www.motorola.com/Consumers/US-EN/Consumer-Product-and-Services/Tablets/ci. MOTOROLA-XOOM-U C] (Q'|

MOTOROLA XOOM - Android Sma...

SIGN UP FOR EMAIL UPDATES

MOBILE PHONES

ACCESSORIES

ALL PRODUCTS

™ . "/
MOTOROLA XO0OM ~ Experience
e e o 0o KEYFEATURES =
powerful dual-core processor Large 10.1-inch HD
and Android™ 3.0 (Honeycomb) widescreen display
- the Android platform designed
specifically for tablets. With its Srﬁef':fculbgﬁydpcg;?](:’?iLFSU::‘E
19.1-mch HD’ wudgscreen _ . the original purchase. Visit
display, you'll enjoy HD video in VerizonWireless.com/Xoom
a thin, light, and powerful tablet. 4GLTEUpgrade for details.)
GET EXCITED Dual-core 1 GHz processor
USERUUME (VERZEN, Android 3.0 (Honeycomb)
designed specifically for
tablets
2 MP webcam and 5 MP
camera with 720p HD video
capture and playback
|| VIEWALLTECHSPECS |
ACCESSORIES g
c—— — ——————————————— ——— - - - - - — - “
S errors occurred in opening the page. For more information, choose Window > Activity. A




XOOM tech specs

® Android 3.0

® |0.] inch touchscreen display
e |280 x 800

e |60 dpi




XOOM tech specs

® NVIDIA Tegra 2 dual-core chipset
® HDMI connector

® twoO cameras

® no physical keyboard
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All Phones Sort by: Newest | Alphabetical

Phones with Google

All Manufacturers
Dell

HTC

LG

Motorola

Samsung

Sony Ericsson

All Operators
ATE&T

Cellular South
Sprint
T-Mobile

US Cellular
Verizon

[ United States @

More countries, operators,
and phones coming soon!

MOTOROLA XOOM™ vitr Google

The Next, Next Generation

Experience the future with MOTOROLA XOOM,
the world's first tablet powered by Android 3.0
(Honeycomb).

MOTOROLA ATRIX™ 4G

MOTOROLA ATRIX 4G the world's most powerful
smartphone.

Dell Streak 7

Introducing Dell™ Streak 7. Share photos, videos
and movies together. It's small enough to carry
around, big enough to gather around.

o= [
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What’s new in Android 3.0?



®0o Android 3.0 Platform Highlights | Android Developers

| <] » J [+ ]Clhttp://developer.android.com/sdk/android-3.0-highlights.html _ [EEE C|
") [ English :] Androi
CNo30I1D
d eve ' D p e rS search developer docs (Seaj
Home Dev Guide Reference Resources Videos Blog
Android SDK Starter Package

Download Android 3.0 Platform Highlights

Installing the SDK

Downloadable SDK Components
Adding SDK Components
* Android 3.0 Platform "ew!

Welcome to Android 3.0!

The Android 3.0 platform introduces many new and exciting

| fegtures for users and developers. This document provides a
API Differences Report » glimpse of some of the new features and technologies, as
» Android 2.3.3 Platform new! delivered in Android 3.0. For a more detailed look at new
» Android 2.3 Platform developer APls, see the Android 3.0 Platform document.

Android 2.2 Platform
Android 2.1 Platform
Android 1.6 Platform

e New User Features

e New Developer Features
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® ‘holographic’ Ul theme
® Action Bar
® Fragments

® Drag and Drop

® Digital Rights Management

® and more...
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Action Bar



“The Action Bar is a widget for activities that
replaces the traditional title bar at the top of
the screen.

By default, the Action Bar includes the
application logo on the left side, followed by
the activity title, and any available items
from the Options Menu on the right side.”




Action Bar
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developers
Home SDK
Android Basics

What Is Android?
Application Fundamentals

Framework Topics

» Activities ™"!

» Services
Content Providers
Intents and Intent Filters
Processes and Threads

v User Interface

Declaring Layout
Creating Menus
Using the Action Bar
Creating Dialogs
Handling Ul Events

» Notifying the User
Dragging and Dropping ™"
Applying Styles and Themes
Building Custom Components

L

O O And
!‘! (I http://developer.android. com/guide/toplcs/ui/actionbar html ¢ Q' Q~ Google @

@ (English @) Android.com

search developer docs

Reference Resources Videos Blog
User Interface >
Using the Action Bar
Quickview

The Action Bar is a widget for activities that
replaces the traditional title bar at the top of the
screen. By default, the Action Bar includes the
application logo on the left side, followed by the
activity title, and any available items from the
Options Menu on the right side. The Action Bar
offers several useful features, including the
ability to:

¢ Display items from the Options Menu
directly in the Action Bar, as "action
items"—providing instant access to key
user actions.

Menu items that do not appear as action
items are placed in the overflow menu,
revealed by a drop-down list in the Action

e Areplacement for the title bar that includes

the application icon and activity title

e Provides action items from the Options Menu

and modes of navigating around the
application

e Supports custom views, including an

embedded search box

« Requires APl Level 11

In this document

Adding the Action Bar
Removing the Action Bar

Adding Action Items

Using the app icon as an action item
Adding an Action View

Adding Tabs
Adding Drop-down Navigation

Styling the Action Bar

F
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android ActionBar

android.accessibilityservice )
android.accounts extends Object

android.animation

android.app java.lang.Object

android.app.admin L»android.app.ActionBar
android.app.backup

android.appwidget

android.bluetooth )

android.content . Class Overview

android.content.pm
android.content.res

android.database R This is the public interface to the contextual ActionBar. The ActionBar acts as a replacement for the title
A
v

bar in Activities. It provides facilities for creating toolbar actions as well as methods of navigating around

android.database.sqlite .
an application.

android drm
W"Wq
ActionBar.Tab

Activity
Summary
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Fragments



“A Fragment represents a behavior or a portion of user
interface in an Activity. You can combine multiple fragments
in a single activity to build a multi-pane Ul and reuse a
fragment in multiple activities.You can think of a fragment
as a modular section of an activity, which has its own
lifecycle, receives its own input events, and which you can
add or remove while the activity is running.”

http://developer.android.com/guide/topics/fundamentals/fragments.html


http://developer.android.com/reference/android/app/Fragment.html
http://developer.android.com/reference/android/app/Fragment.html
http://developer.android.com/reference/android/app/Activity.html
http://developer.android.com/reference/android/app/Activity.html
http://developer.android.com/guide/topics/fundamentals/fragments.html
http://developer.android.com/guide/topics/fundamentals/fragments.html

* Fragments decompose application functionality and Ul
into reusable modules

* Add multiple fragments to a screen to avoid switching
activities

* Fragments have their own lifecycle, state, and back stack

* Fragments require APl Level "Honeycomb" or greater

http://developer.android.com/guide/topics/fundamentals/fragments.html


http://developer.android.com/guide/topics/fundamentals/fragments.html
http://developer.android.com/guide/topics/fundamentals/fragments.html

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="horizontal"
android:layout width="match parent”
android:layout height="match parent">

-
<fragment class="com.example.android.apis.app.TitlesFragment"

android:id="@+id/titles" android:layout weight="1"
android:layout width="0px"
android:layout height="match parent" />

\_

<FrameLayout android:id="@+id/details" android:layout weight="1"
android:layout width="0px"
android:layout height="match parent" />

</LinearLayout>




public static class TitlesFragment extends ListFragment {
private boolean mDualPane;
private int mCurCheckPosition = 0;

@Override

public void onActivityCreated(Bundle savedState) {
super.onActivityCreated(savedState);
// do something here

@Override

public void onSavelInstanceState(Bundle outState) {
super.onSavelInstanceState(outState);
outState.putInt("curChoice”, mCurCheckPosition);

}
@Override
public void onListItemClick(ListView 1, View v,
int pos, long id) {
// do something here
}
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android Fl'agment
android.accessibilityservice )
android.accounts extends Object _ _
android.animation |mplements Com Callbacks W
android.app
android.app.admin java.lang.Object
android.app.backup L»android.app.Fragment
android.appwidget
android.bluetooth P Known Direct Subclasses
android.content DialogFragment, ListFragment, PreferenceFragment, WebViewFragment
android.content.pm
android.content.res .
android.database - .
android.database.sqlite . Class Overview
android drm 4
T Tagmicimniorcauoiumoy . . . . 1 . . . . .
~|| A Fragment is a piece of an application's user interface or behavior that can be placed in an Activity.
FragmentManager - L . : : .
4 || Interaction with fragments is done through FragmentManager, which can be obtained via
FragmentTransaction 1= .. N~
v Activity.getFragmentManager() and Fragment.getFragmentManager A
Instrumentation | s

Use Tree Navigation




®no Android Developers Blog: Fragments For All

@ (English | 4] Android.com

nn l'! 1 http://android-developers. blogspot com/2011/03/fragments-for-all.html E ¢ P Qr Google

ano30i1D

developers

Fragments For All

Posted by Tim Bray on 03 March 2011 at 1:06 PM
[This post is by Xavier Ducrohet, Android SDK Tech Lead. — Tim Bray]

A few weeks ago, Dianne Hackborn wrote about the new Fragments AP|, a mechanism that makes it easier for
applications to scale across a variety of screen sizes.

However, as Dianne noted, this new API, which is part of Honeycomb, does not help developers whose applications
target earlier versions of Android.

Today we've released a static library that exposes the same Fragments API (as well as the new LoaderManager and a
few other classes) so that applications compatible with Android 1.6 or later can use fragments to create tablet-

compatible user interfaces.

This library is available through the SDK Updater; it's called “Android Compatibility package”.

Home SDK Dev Guide Reference Resources Videos

p
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Drag and drop
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android.telephony.gsm
android.test
android.test.mock
android.test.suitebuilder
android.text
android.text.format
android.text.method
android.text.style
android.text.util
android.util

android.view.accessibility

nn !! (I http://developer.android.com/reference/android /view/DragEvent.html

DragEvent | Android Developers

search developer docs

Dev Guide Resources

DragEvent

'
extends Object
- implements Parcelable

java.lang.Object

~randroid.view. DragEvent
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public class Summary: Constants | Inherited Constants | Fields |
Methods | Inherited Methods | [Expand All]
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View.OnDraglistener | Android Developers

4 (> } |(C]http://developer.android.com/reference/android/view/View.OnDragListener.html c Qr Google
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Home SDK

android.telephony.gsm
android.test
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android.util
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Dev Guide

android.test.suitebuilder u‘

@ [ English 4|

search developer docs

Resources Videos

public static interface Since: APl Level 11

View.OnDragListener

android.view.View.OnDragListener

Class Overview

Interface definition for a callback to be invoked when a drag is
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Renderscript



“The Renderscript rendering and computational APIs
offer a low-level, high performance means of carrying out
mathematical calculations and 3D graphics rendering.”
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Dev Guide Resources

android.renderscript | Android Developers

¢ P(Qr Google

) [English ﬁ Android.com
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search developer docs

Videos Blog
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android.net mn
android.net.http

android.net.sip

android.net.wifi n
android.nfc
android.nfc.tech
android.opengl
android.os
android.os.storage
android.preference

android.provider

android.renderscript

android.sax

android.service.wallpaper
android.speech

-
android.speech.tis 2
o Lok Al ™ A 4
a
v

Classes

Allocation

Use Tree Navigation

Core

package Since: API Level 11 h

android.renderscript

The Renderscript rendering and computational APls offer a low-level, high performance means of carrying
out mathematical calculations and 3D graphics rendering. An example of Renderscript in applications
include the 3D carousel view that is present in Android 3.0 applications such as the Books and YouTube
applications. This API is intended for developers who are comfortable working with native code and want to
maximize their performance critical applications.

Renderscript adopts a control and slave architecture where the low-level native code is controlled by the
higher level Android system that runs in the virtual machine (VM). The VM code handles resource
allocation and lifecycle management of the Renderscript enabled application and calls the Renderscript
code through high level entry points. The Android build tools generate these entry points through reflection
on the native Renderscript code, which you write in C (C99 standard). The Renderscript code does the
intensive computation and returns the result back to the Android VM.

You can find the Renderscript native APIs in the <sdk_root>/platforms/android-
3.0/renderscript directory. The Android system APIs are broken into a few main groups:

Q<> €



New animation API



android.animation | Android Developers

| o+ (Ihttp://developer.android.com/reference/android /animation/package-summary.html ¢ | [Q~ Google

Use Tree Navigation

") [ English ﬁ Android.com
an>301d
d EVE | D p e fS search developer docs
Home SDK Dev Guide Reference Resources Videos Blog O Fiter by API Level: [ 11 ¢
— —]|
Package Index | Class Index d package Since: API Level 11
android android.animation
android.accessibilityservice
android.accounts
These classes provide functionality for the property animation system, which allows you to animate object
android.app properties of any type. int, float, and hexadecimal color values are supported by default. You can
android.app.admin animate any other type by telling the system how to calculate the values for that given type with a custom
android.app.backup TypeEvaluator.
android.appwidget
android.bluetooth You can set many different types of interpolators (contained in android.view.animation), specify
android.content keyframes, or group animations to play sequentially or simultaneously (with AnimatorSet) to further
android.content.pm control your animation behaviors.
android.content.res
android.database || Fora guide on how to use the property animation system, see the Animation developer guide.
android.database.sqlite A
android drm v
il .
SESTROS 4+ Interfaces
Animator.AnimatorListener 1Y -
<« » A
Animator.AnimatorListener An animation listener receives notifications from an v




Digital Rights Management API
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android.animation
android.app
android.app.admin
android.app.backup
android.appwidget
android.bluetooth
android.content
android.content.pm
android.content.res
android.database

0

android.database.sqlite
android.gesture

android.graphics
android.graphics.drawable
android.graphics.drawable.shapes

.~ Lol A .

N~
A

0

Interfaces

DrmManagerClient.OnErrorListener

DrmManagerClient.OnEventListener
Use Tree Navigation

A
v

package
android.drm

Interfaces
DrmManagerClient.OnErrorListener

DrmManagerClient.OnEventListener

DrmManagerClient.OninfoListener

——]

Since: API Level 11

Interface definition of a callback to be invoked to
communicate the error occurred

Interface definition of a callback to be invoked to
communicate the result of time consuming APIs
asynchronously

Interface definition of a callback to be invoked to
communicate some info and/or warning about
DrmManagerClient.
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) € DrmManagerClient | Android Developers
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androld.app.backup DrmManagerClient
android.appwidget
android.bluetooth extends Object
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android.content.res lava.lang.Object
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android.gesture .
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NETEELA X

The same security issues that have led to piracy
concerns on the Android platform have made it
difficult for us to secure a common Digital Rights
Management (DRM) system on these devices. [...]
Although we don’t have a common platform
security mechanism and DRM, we are able to work
with individual handset manufacturers to add
content protection to their devices.

November 2010
http://blog.netflix.com/2010/11/netflix-on-android.html


http://blog.netflix.com/2010/11/netflix-on-android.html
http://blog.netflix.com/2010/11/netflix-on-android.html

NETEELA X

Unfortunately, this is a much slower approach and
leads to a fragmented experience on Android, in
which some handsets will have access to Netflix
and others won't.

We will also continue to work with the Android
community, handset manufacturers, carriers, and
other service providers to develop a standard,
platform-wide solution that allows content providers
to deliver their services to all Android-based devices

November 2010
http://blog.netflix.com/2010/11/netflix-on-android.html


http://blog.netflix.com/2010/11/netflix-on-android.html
http://blog.netflix.com/2010/11/netflix-on-android.html

Application development
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information about what's
the version notes.

developer APls for an optimized experience
on tablets and similar devices. For more
in Android 3.0, read

If you have an existing SDK, add Android 3.0
as an SDK component. If you're new to

Android, install the SDK starter package.

service that lets you distrnbute
your apps to handsets.

Learn more »

SDK Dev Guide Reference Resources Videos Blog
‘
Android 3.0 is herel
Android 3.0 is now available for the Android
SDK. It offers a redesigned Ul and all new /7

Contribute

Android Open Source Project
gives you access to the entire
platform source.

Learn more »

update your apps.

Target Devices

The Device Dashboard
provides information about
deployed Android devices to
help you target suitable device
configurations as you build and

i
4 »
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Android SDK | Android Developers

gg l'! C]http //developer.android.com/sdk/index.html Q' Q- Google

ano30I1D

developers

Android SDK Starter Package
Download

Installing the SDK

Downloadable SDK Components
Adding SDK Components

» Android 3.0 Platform new!

» Android 2.3.3 Platform new!

» Android 2.3 Platform
Android 2.2 Platform
Android 2.1 Platform
Android 1.6 Platform
Android 1.5 Platform

» Older Platforms

SDK Tools, r10 new!
Google USB Driver, r4

search developer docs

Home m Dev Guide Reference Resources Videos

@ ( English

4] Android.com

Blog
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Download the Android SDK

Welcome Developers! If you are new to the Android SDK, please read the steps below,

for an overview of how to set up the SDK.

If you're already using the Android SDK, you should update to the latest tools or platform
using the Android SDK and AVD Manager, rather than downloading a new SDK starter

package. See Adding SDK Components.

Windows android-sdk_r10- 32832260 1e42b8f528d9ca6d9b887c58c6f1b9a2

windows.zip bytes

o« O



Android emulator
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Emulator performance



About emulator performance

Because the Android emulator must simulate the ARM instruction set
on your computer and the WXGA screen is significantly larger than a

typical virtual device, emulator performance is much slower than a real
device.

source: developer.android.com




In particular, initializing the emulator can be slow and can take several
minutes, depending on your hardware. When the emulator is booting,
there is limited user feedback, so please be patient and wait until you
see the home screen (or lock screen) appear.

source: developer.android.com




However, you don't need to boot the emulator each time you rebuild
your application—typically you only need to boot at the start of a
session and keep it running. Also see the tip below for information
about using a snapshot to drastically reduce startup time after the first
Initialization.

We're working hard to resolve the performance issues and it will
iImprove In future tools releases.

source: developer.android.com
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Available Software

Check the items that you wish to install.

Work with: [https://dl-ssl.google.com/android/eclipse/-https://dI-ssl.google.com/android/eclipse/ B ( Add... )

Find more software by working with the "Available Software Sites" preferences.

'8 . N
[ type filter text 1
Name Version

g v 00U Developer Tools

g <= Android DDMS 10.0.0.v201102162101-104271

4 1+ Android Development Tools 10.0.0.v201102162101-104271

<
8 i{BAndroid Hierarchy Viewer 10.0.0.v201102162101-104271
8 @:Android Traceview 10.0.0.v201102162101-104271

( selectAll ) [ DeselectAll ) 4 items selected

Details
g Show only the latest versions of available software [T Hide items that are already installed
g GCroup items by category What is already installed?

g Contact all update sites during install to find required software

@ ( <Back ) @owNexvsw®d ( Cancel ) ( Finish




e~  |Prefeences |

~ type filter text

» Ceneral

» Android

> Ant

» Data Management

» Coogle

> Help

»Install /Update

b Java

> Java EE

b Java Persistence

> JavaScript

» Maven

» Plug-in Development

» Remote Systems

»Run/Debug

> Server

P Tasks

»Team
Terminal

» Usage Data Collector
Validation

»Web

»Web Services

»WindowBuilder

> XML

Android

C:)v vy v

Android Preferences

SDK Location:

fusr/local /android-sdk-mac_x86|

( Browse... )

Note: The list of SDK Targets below is only reloaded once you hit 'Apply' or 'OK'".

'Target Name Vendor Platform APl Lev
Android 1.5 Android Open Source Project 1.5 3
Google APIs Google Inc. 1.5 3
Android 1.6 Android Open Source Project 1.6 4
Google APIs Google Inc. 1.6 4
Android 2.1-updatel Android Open Source Project 2.1-update 7
Google APIs Google Inc. 2.1-update 7
Android 2.2 Android Open Source Project 2.2 8
Google APIs Google Inc. 2.2 8
CALAXY Tab Addon Samsung Electronics Co., Ltd. 2.2 8
CALAXY Tab Addon Samsung Electronics Co., Ltd. 2.2 8
CALAXY Tab Addon Samsung Electronics Co., Ltd. 2.2 8
Android 2.3.1 Android Open Source Project 2.3.1 9
Google APIs Google Inc. 2.3.1 9
Android 2.3.3 Android Open Source Project 2.3.3 10
GCoogle APls Google Inc. 2.3.3 10
Android 3.0 Android Open Source Project 3.0 11
Google APIs Google Inc. 3.0 11

(' Restore Defaults ) (  Apply )

@

( Cancel

) k)

4




Select a wizard

Wizards:

(type filter text

o)

@ Class
€V Interface

2% Java Project
$# Java Project from Existing Ant Buildfile
14 Plug-in Project

» (= General

¥ (= Android

.Jf Android Project
Jﬁ]Android Test Project

«cil Android XML File
» (= Connection Profiles

P> (= CVS -
» (= Eclipse Modeling Framework A
> = EB b
@ ( < Back ) € Next> ) (  cCancel ) ( Finish )




New Android Project

Creates a new Android Project resource.

8 Use default location

Location:

/Users/sean/Documents/workspace-android30/myap

O Create project from existing sample

Samples: | AccelerometerPlay

Browse...

‘D’

Build Target

Target Name
(") Android 1.5
(") Google APIs
(") Android 1.6
(") Google APIs
(") Android 2.1-updatel
("] Google APIs
() Android 2.2
(") Google APIs
(") GALAXY Tab Addon
(") GALAXY Tab Addon
(") GALAXY Tab Addon
(] Android 2.3.1
(") Google APIs
(") Android 2.3.3

Vendor

Android Open Source Project
Google Inc.

Android Open Source Project
Google Inc.

Android Open Source Project
Google Inc.

Android Open Source Project
Google Inc.

Samsung Electronics Co., Ltd.
Samsung Electronics Co., Ltd.
Samsung Electronics Co., Ltd.

Android Open Source Project
GCoogle Inc.
Android Open Source Project

Caoglelnc

™ Android 3.0
(") Google APIs

Platform API L
1.5 3
1.5 3
1.6 4
1.6 4
2.1-updatel?
2.1-updatel?

Android Open Source Project
Google Inc.

2.2 8
2.2 8
2.2 8
2.2 8
2.2 8
2.3.1 9
2.3.1 9
2.3.3 10
233 10
3.0 11
3.0

Standard Android platform 3.0

Properties
Application name: myapp
Package name: my.app

8 Create Activity: MyAppActivity

Min SDK Version: 11

e

@ C

<Back ) [ Next>

) ( Cancel

) € Finish )




Android Application

Create, manage, and run configurations

BRX |33

Name:  myapp

p
 type filter text

myapp

E Generic Server

[G GWT JUnit Test
Ju GWT JUnit Test
5 HTTP Preview
& J2EE Preview
7] Java Applet

‘55 JavaScript
Ju JUnit

m2 Maven Build

(=)

¥ [3] Android Application

Jﬁ'Android JUnit Test
E Apache Tomcat
[GH Compile GWT Applicat

& Eclipse Application
@ Eclipse Data Tools

E Generic Server(Externa
[G]GWT Application

[7])ava Application

j%'JUnit Plug-in Test

)

4 0SGi Framework
E Remote Java Applicatio\;
JuyTask Context Test

Delrl

Filter matched 25 of 25 items

w Targeq B Commoﬂ

Project:

‘myapp

Launch Action:

® Launch Default Activity

(O Launch:

N

“ar

() Do Nothing

@




No compatible targets were found. Do you wish to a add new Android Virtual

w Device?

( No )ﬁ




List of existing Android Virtual Devices located at /Users/sean/.android/avd
Installed packages
Available packages AVD Name ITarget Name ]Platform [APl Level New...
- No AVD available - -
Edit...
Delete...
Repair...
Details...
Start...
Refresh
A valid Android Virtual Device. | A repairable Android Virtual Device.
X An Android Virtual Device that failed to load. Click 'Details' to see the error.
7




| Android 3.0 - API Level 11

SD Card: |
@ size: 50 MiB s
O File: ( Browse...

Snapshot: = )
(") Enabled

Skin: ( )
® Built-in: | Default (WXGA) B
(O Resolution: X

Hardware: = )
Property Value New...
Abstracted LCD density 160 :
Keyboard lid support no Delete
Max VM application heap si 48
Device ram size 256

(] Override the existing AVD with the same name

( Cancel ) M




List of existing Android Virtual Devices located at /Users/sean/.android/avd
Installed packages :
Available packages AVD Name Target Name Platform APl Level New...
~ AVD30 Android 3.0 3.0 11
Edit...
Delete...
| Repair...
Details...
Start...
Refresh
~ A valid Android Virtual Device. .| A repairable Android Virtual Device.
X An Android Virtual Device that failed to load. Click 'Details' to see the error.
: Z




Select a device compatible with target Android 3.0.

() Choose a running Android device

TSeriaI Number AVD Name Target Debug State

® Launch a new Android Virtual Device

AVD Name Target Name Platform APl Level Details...
D30 Android 0 U
Start...
Refresh
Manager...

( cCancel ) moks)




Sample code



]

O C lechnical Resources | Android Developers
!l., Clhttp://developer.android.com/resources/browser.html?tag=sample ¢ [ (Qr Google

@ [ English @4 Android.com

search developer docs

anNo3x0I1D

developers

Home SDK Dev Guide Reference Videos Blog

a =
Technical Resources e HOMeE
. ..
Getting the Samples ' Q A home screen replacement application.
Accelerometer Play ™%
Accessibility Service ™"
APl Demos
Backup and Restore we. HONGycomb Gallery neW! n
Bluetooth Chat ‘ Sample for New Features and User Interface
cB:usItr:zts;Card Q An image gallery application using APIs that are new in Android 3.0 (a.k.a. Honeycomb).
on anager ;

Cube Live Wallpaper
Home
Honeycomb Gallery ™! s, JEtBO
JetBoy Sample for Game Development and Multimedia
Lunar Lander . . . . .
Multiple Resolutions A game that demonstrates the SONiVOX JET interactive music technology, with JetPlayer.
NFC Demo
Note Pad
Renderscript "' L s UNAr Lander L
SampleSyncAdapter ) | Sample for Game Development and Multimedia ) |
Searchable Dictionary v2 E v
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ano30i1D

developers

Home SDK

search developer docs

Dev Guide Reference Resources Videos

v Sample Code
Getting the Samples
Accelerometer Play "e%!
Accessibility Service "eW!
APl Demos
Backup and Restore
Bluetooth Chat
BusinessCard
Contact Manager
Cube Live Wallpaper
Home

JetBoy

Lunar Lander

Multiple Resolutions

DAandarnaring NEW! L

NFC Demo -

@ (English |4) Android.com

Blog

Sample Code >

«— Back

including:

e Fragments
e The action bar and contextual action bar

Drag and drop

e The new android.animation framework
e Custom notifications

Note Pad 2
Y

—————————————— Yl

This is a demo application highlighting how to use some of the new APIs in Honeycomb,

HoneycombGallery - Honeycomb Gallery n

< >




API differences



@AndroidDev

AndroidDev

The Honeycomb diffs:
http://developer.android.com/sdk/api_di
ff/11/changes.html

22 Feb via web Favorite Retweet & Reply

Retweeted by sarveshgupta89 and 68 others

LEIYTLEN - QL+ K




800

AP Differences between 10 and 11

nn “ (1 http://developer.android.com/sdk/api_diff/11/changes.html ¢ Q' Google |

Select a Diffs Index:
All Differences
By Package
By Class
By Constructor
By Method
By Field

Filter the Index:

All Differences
Removals
Additions
Changes

Listed as: Added, Remeved, Changed

A BCDEFGHIJKLMNOPAQR
STUVWTOP

aberdpdates ()
AbsListView

AbstractCursor

AbsLlstVlew.MuIthholceModeUstene.\’
AbsListView.SelectionBoundsAdjuste

A
v

Android Developers | Androi

'
aN>301D API Diff Specificati )

developers -

Generated 2011.02.19 ’

Android API Differences Report

This report details the changes in the core Android framework API between two AP| Level specifications. It
shows additions, modifications, and removals for packages, classes, methods, and fields. The report also
includes general statistics that characterize the extent and type of the differences.

This report is based a comparison of the Android API specifications whose API Level identifiers are given in
the upper-right corner of this page. It compares a newer "to" API to an older "from" API, noting all changes
relative to the older API. So, for example, API elements marked as removed are no longer present in the "to"
API specification.

To navigate the report, use the "Select a Diffs Index" and "Filter the Index" controls on the left. The report
uses text formatting to indicate interface names, 1inks to reference documentation, and links to
change description. The statistics are accessible from the "Statistics" link in the upper-right cormner.

For more information about the Android framework API and SDK, see the Android Developers site.

Added Packages

android.animation

<« »(

http://developer.android.com/sdk/api_diff/ | |/changes.html



Best practices



®O0o Android Developers Blog: Best Practices for Honeycomb and Tablets

practices-for-honeycomb-and.html| ¢ | [Qr Google

") [ English Q Android.com
aN>301d
Home SDK Dev Guide Reference Resources Videos

. ~
Best Practices for Honeycomb and Tablets
Posted by Tim Bray on 23 February 2011 at 10:00 AM
The first tablets running Android 3.0 (“*Honeycomb®) will be hitting the streets on Thursday Feb. 24th, and we've just posted the full SDK release. We
encourage you to test your applications on the new platform, using a tablet-size AVD.
Developers who've followed the Android Framework's guidelines and best practices will find their apps work well on Android 3.0. This purpose of this
post is to provide reminders of and links to those best practices.
Moving Toward Honeycomb
There's a comprehensive discussion of how to work with the new release in Optimizing Apps for Android 3.0. The discussion includes the use of the
emulator; most developers, who don't have an Android tablet yet, should use it to test and update their apps for Honeycomb.
While your existing apps should work well, developers also have the option to improve their apps’ look and feel on Android 3.0 by using Honeycomb
features; for example, see The Android 3.0 Fragments API. We'll have more on that in this space, but in the meantime we recommend reading
Strategies for Honeycomb and Backwards Compatibility for advice on adding Honeycomb polish to existing apps.
Specifying Features Y

v

http://android-developers.blogspot.com/201 1/02/best-practices-for-honeycomb-and.html
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d eve l D p e fS search developer docs
Home SDK Dev Guide Reference Resources Videos Blog
RPPICATOT CICETTSITY , —
» In-app Billing ™" r n
Market Filters s s = .
Optimizing Apps for Android 3.0
Developing In this document
Introduction Set Up Your SDK with Android 3.0
» Managing Virtual Devices If you're developing an Android application, Android 3.0 Optimize Your App for Tablets and Similar
Using Hardware Devices introduces several features that allow you to enhance Devices
» Managing Projects your user's experience on tablets and similar devices. Upgrade or Develop a New App for Tablets and
Any application you've already published is compatible Similar Devices

* Bullding and Running with devices running Android 3.0, by default, because

: ? ebugging Android applications are forward-compatible. However,
esting .
T there are some simple changes you should make to
ools - L .
optimize your application for tablet-type devices.
Publishing
This document shows how you can optimize your existing application for Android 3.0 and maintain compatibility with
Signing Your Applications older versions or upgrade your application completely with new APIs.
Versioning Your Applications
Preparing to Publish To get started:

Publishing Your Applications
1. Set up your SDK with Android 3.0.

Best Practices
~ 2. Then choose to either optimize or upgrade: ~
Compatibility A A
Iv a. Optimize Your App for Tablets and Similar Devices. Iv

Supporting Multiple Screens




®no MOTODEV > Documentation & Tools > Android Technical Library > Motorola XOOM™ Tablet Programming Tips
4 | » -+ @http://developer.motorola.com/docstools/Iibrary/motorola—xoom—tablet-programming—tips/ C] (Q' Google )

MOTODEV > Documentation & To...

AA MOTODEV DOCS & TOOLS  PRODUCTS  SUPPORT  COMMUNITY  NEWS & EVENTS I scancH

Weicome to MOTODEV | Join | Log In

MOTODEV > Documentation & Tools > Android Technical Library > Motorola XOOM™ Tablet Programming Tips

Motorola XOOM™ Tablet Programming Tips coonsopsze @B PrintDocument

Welcome to the next evolution in tablets. Motorola XOOM ™
is a touch tablet that provides the most enjoyable and
immersive mobile video experience today. With a large, 10.1-
inch, full touchscreen display, watch videos and movies in
brilliant high def 1080p resolution. Its screen size and shape
are optimized for 16:9 widescreen format, so movies fill the
screen. An HDMI connector allows content to be played back
on any HDTV. Users can rotate seamlessly between front
and rear cameras. The built in gyroscope and barometer
extend the offering of available sensors. At the center of the
tablet sits an NVIDIA Tegra 2 dual-core chipset, which sets
the stage for a better performing, media-rich device.

Share This Page
Bookmark and Share

Table of Contents

Screen

Touch tablet

Resolution and resources
Text and screen size
Expanded camera class
Dual-core processor
What's next?

vV VvV V VvV VvV VvV Vv

In preparation for the tablet, some general programming
guidelines are provided here.

Screen

The first obvious feature of Motorola XOOM is the screen
size. It measures 10.1 inches diagonally and displays 1280 x
800 physical pixels. This could impact your application in
various ways as described throughout this article.

3 errors occurred in opening the page. For more information, choose Window > Activity. A




What'’s next!



® O O  Eric Schmidt: Next Version of Android will ...rbread - Droid Life: A Droid Community Blog

4 | > + [E=http://www.droid-life.com/2011/02/15/eric-schmidt-next-vers: c v Google _

Eric Schmidt: Next Version Of Android Wil
“Combine” Honeycomb And Gingerbread
21 ;

During his keynote speech today at MWC, Eric Schmidt helped clarify what the future version of Android
will end up being. There has been a lot of talk on whether or not Honeycomb would be available to phones
or if the version to follow Gingerbread would simply pull certain parts out of its tablet brother. According to
Schmidt, they will essentially be “combined”...

“‘We have OS called Gingerbread for phones, we have an OS being previewed now for tablets called
Honeycomb. You can imagine the follow up will start with an I, be named after dessert, and will combine
these two.”




®no The Future Version Of Android Isn’t Called Ice Cream. It's Ice Cream SANDWICH.
‘ 4| » ‘ 4+ [TChttp://techcrunch.com/2011/01/11/android-ice-cream-sandw ¢ (Q' ice cream O)

TechCrunch ;

What's Hot: SXSW Android Apple Facebook Google Groupon Microsoft Twitter Zynga

) Round-The-Clock SXSW Coverage »

The Future Version Of Android Isn’t Called Ice
Cream. It’s Ice Cream SANDWICH.

Jason Kincaid ELike 402 [EEEZY | 175 | W Tweet| 593 5 | Digg* |
Jan 11, 2011 133 Comments




Final thoughts

Android 3.0 is for tablets, not phones
XOOM is available now
Additional Honeycomb tablets coming soon

Learn the Fragments API



Thank you
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